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NWA Quality Analyst Version 6.1 Patch
Maintenance Release Update Notes
December 2007

This patch updates releases 2.3.157, 2.3.175, 2.3.185, 2.3.237, 2.3.245, and 2.3.278 of
NWA Quality Analyst Version 6.1 to the newest release.  The new release (2.3.283)
includes minor enhancements and fixes some problems found in the previous releases
(see list below).

This maintenance release is being provided only to customers who have purchased
NWA Quality Analyst maintenance.  The patch will only upgrade Quality Analyst
6.1 releases 2.3.157, 2.3.175, 2.3.185, 2.3.237, 2.3.245, and 2.3.278 to release 2.3.283.
If you are on maintenance and have release 2.3.144 of NWA Quality Analyst 6.1,
contact NWA Customer Service for a replacement CD.

To update using this patch, you must have NWA Quality Analyst installed on the
system to be updated.  In addition, you will also need your original NWA Quality
Analyst Version 6.1 installation CD.

You will not be required to enter a new Activation Key.  This new release will use the
Activation Key entered when your original QA 6.1 was installed.

This maintenance release addresses a limited number of issues.  As few users have
reported the problems addressed by this release, you may want to review the list of new
features and fixes (see below) before you decide to update.

Note: This software is provided as a replacement of an existing, legally licensed product,
and is covered by the license agreement for that product.  The license does not allow for
the installation or use of this product on a system or systems other than as covered by the
initial license.

How to upgrade to release 2.3.283

We have posted a patch on our web site:

http://www.nwasoft.com/download/qa61patch283.htm

Click on the link or enter the address into your browser and follow the instructions when
you connect to the site.  The patch install file ‘QA6283.msp’ will be downloaded.  Follow
the directions below to complete the patch process.
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How to patch NWA Quality Analyst 6.1 to release 2.3.283

Single User Installation
To patch a Single User installation, double-click on QA6283.msp. You will need the
NWA Quality Analyst 6.1 CD.

LAN Network Installation Point
The recommended method of patching a LAN installation is to patch the Network
Installation Point, and then reinstall NWA Quality Analyst on each of the workstations.
The new version will replace the previous version.

To patch the Network Installation Point, use the command line:
msiexec /p QA6283.msp /a setup.msi

Setup.msi is the msi file in the Network Installation Point, so the command above may
need to include the paths to the msp and msi files:

msiexec /p "C:\QA Patch\QA6283.msp" /a F:\NWAQA\setup.msi

It is best to run the patch from the computer that contains the Network Installation Point.
After patching, NWA Quality Analyst can be reinstalled on each workstation.  See page
13 of the QA 6.1 Installation Guide (also available in electronic form on the QA 6.1 CD).

LAN Workstation
An alternative to reinstalling NWA Quality Analyst on the workstations is to patch each
workstation.  To patch a workstation, double-click on QA6283.msp at each workstation.
The Network Installation Point will need to be available, and it must contain the previous
version of NWA Quality Analyst, not the new version.

If the Network Installation Point has been patched to the new version, workstations can
no longer be patched.  NWA Quality Analyst must be reinstalled on each workstation.

To check if the update was successful:

Start up Quality Analyst.  Go to the pull-down "Help" menu, and select "About Quality
Analyst".  Confirm that the Editor release number is 2.3.283.

Please contact NWA Quality Analyst Technical Support if you have any questions.



Page 3 of 13

Fixes to release 2.3.278
========================

The following problems have been fixed in release 2.3.283:

With "keyed" files, a graphics comment that should be beyond the left margin of the chart
could instead be partially plotted on the chart.

Enhancements to release 2.3.245
===============================

Graphics
--------
An option to print or not print a border around the charts is now available in the
"Advanced Graphics Options" of the NWA Graphics.

Callouts in control charts can now include the X, Y coordinates.

Graphics output file formats now include GIF format.

Charting and Analysis
---------------------
Westgard rules have been added to the Pattern Rules.

Capability Report can now write Data File (DAT) output, including MCAPREP in RUN
files.

Instead of reporting an "Insufficient Data" error message, a Graphics window with that
message will be displayed.

CUSUM Parameters include an option to "Omit SPC Limits and Out-of-Control
Symbols" on CUSUM charts.

Database Connectivity
---------------------
There is a new function "DATEONLY" to retrieve just the date portion of a DateTime
variable.

For denormalized data sets, selecting key columns adds an "Order By" clause to the
database query.  This insures the data records will arrive in the correct order.

Fixes to release 2.3.245
========================
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The following problems have been fixed in release 2.3.278:

Graphics and Printing
---------------------
With some printer drivers, attempting setup printer reported: Run-time error '-
2147417848 (80010108)'.

The "line styles" shown on screen were not the same as those that were printed.

When a RUN file saved a graph as a JPG file, the JPG was always low quality.

Run-time error '13' Type mismatch when printing / changing printer in Exception Report.

Run files wouldn't print landscape unless the NWAGraph.CFG file exists and has a
"Printer Name=" line.

Charting and Analysis
---------------------
QAEDIT allowed illegal control chart region to be added.

Histogram Statistics Settings problem if the middle column of selected statistics was
blank.

Capability Report had a display problem with Cpk values over 100.

The column headers were not aligned properly if a Capability Report was pasted to
Excel.

Saving a data set from the data editor could change the Histogram's capability calculation
parameter to always use the Normal distribution.

Pattern Rule "n alternating" was off by one at start of chart.

Database Connectivity
---------------------
An external database Date Filter could fail if Time information was retrieved in a Date
field.

The database engine file DAO360.DLL was installed into an incorrect directory.

D/M/Y date format and Ask filter could reverse Month and Day parts.

Changing Key Column in Database Definition wasn't recognized as a change in data set.

Database Table and View names containing comma space ", " weren't saved to NWH.
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Denormalize Data sets could miss records if column names contain periods ".".

Carriage return / line feed in database fields could cause problems in QA connectivity.

Specifications from External Database Connectivity were not saved with Save button.

Program Operation
-----------------
It was possible to accidentally get "open as read-only" checked; then users couldn't save
the file when exiting.

Data Filter with Exclusive selection and no "From" value would return no data.

Dates far in the future (over 8000 years) could cause "error 5" in a data filter.

The MPCAP "A" (append to output) option didn't work with the QAEDIT.CFG setting
"UseTempAsIODir=1".  Note that this does require full file paths to work.

A Read-Only NWH file didn't result in a Warning or Error.

Using an Evaluation Key required Registry permissions not available in Windows Vista.

The QA Help didn't work on Windows Vista.

The RUN file command "UpdateNWH" cleared Data Tags and Row Tags.

In the Data Editor, writing a Process Capability Report to a data set followed by a "Save
as" could result in "Error 9 Subscript out of range".

System Date references failed if Windows was set to Chinese language.

Duplicate graphics comments could accumulate in an NWH file.

Enhancements to release 2.3.237
===============================

Printer margins can now be specified in the NWA Graphics.  This is done in File > Page
Setup.  The margins, in inches, can be set separately for Top, Bottom, Left, and Right,
and are automatically saved.

Fixes to release 2.3.237
========================
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The following problems have been fixed in release 2.3.245:

Tagging rows could fail under some circumstances.

Stability / Shelf-Life defaults have been changed in the regression procedure.

Enhancements to release 2.3.185
===============================

The Date data type can now contain Time as well. For example: “6/21/06 14:19”.  To
accommodate the longer DateTime values on graphics output, DateTime can be wrapped
onto two lines of X-axis labels. Additionally, the retrieval of DateTime information from
database fields can be turned off, to allow Quality Analyst to act the same as previous
releases.  See the QA User's Manual, Chapter 3, the sections on "Description Data
Types", "Filtering on a DateTime Variable", and "Sorting Data" for discussion of the new
capability.  See "Handling DateTime Fields" in "Database Options" in Chapter 12 for
information on turning this feature off.

Graphics copied to the clipboard now have a better appearance, and are available in more
formats. Most Windows applications will automatically use the best format when pasting
(Windows Metafile 2), but it may be necessary to use "Paste Special" in some programs
(such as Powerpoint) to select that format.  Additionally, text-only reports displayed in
graphics can now be pasted as text, which allows Quality Analyst statistical results to be
pasted to spreadsheets such as Microsoft Excel.  Previous releases of QA 6.1 saved text
to the clipboard as graphic images.

An "Advanced" graphics settings dialog is now available.

Printer setup has been reworked. There are more options, and the options are retained
between runs of Quality Analyst.

The Stability / Shelf-Life options in Single Variable Regression have been enhanced to
include two-sided confidence intervals and improved statistical reporting in the footer.

The Export to CSV file can now optionally list the variable names on the first line of the
file.

A new Run file command “NoWorkingMessage” has been added. This suppresses the
“Working…” activity message for users who do not want this displayed during Run File
execution.

Fixes to release 2.3.185
========================
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The following problems have been fixed in release 2.3.237:

Graphics
--------
The Printer couldn’t be switched from default on some computer systems.

Graphics copied to the clipboard from a small graphics window looked bad.

A graphics file was not re-opened if a file of the same name was already displayed.

Connectivity
------------
Clicking “File>Save” immediately after opening a connectivity data wouldn’t actually
save the data set.

Not all of the “Specifications from a Database” parameters could be removed from a data
set.

Database field names in denormalized connectivity data sets could not contain square
brackets, “[]”.

“Specifications from a Database” could miss specifications if mixed case field identifiers
were used.

The database password for “Specifications from a Database” was always saved to the
data set, even if this was not desired.

The Quality Analyst Run File Interpreter would fail to convert an HED file to an NWH
file if database connectivity parameters were used.

An external database filter of a time variable with the time spanning midnight would fail.

In the Data Editor, Row Tags weren’t cleared before a Connectivity Data Set was opened.

Control Limit Regions could be deleted when an External Database was queried.

QA Editor
---------
Printing data from the Editor always printed on the system default printer.

The QA Editor didn’t accept replaceable parameters (such as ^MACHINE=”RED”) on its
command line.
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Histogram footer settings were set incorrectly if no statistics were present in the middle
column.

On the Center Line and Limits dialog, the Individuals chart control limit calculations
were always based on average Range, even when the user requested they be based on
average Standard Deviation.

Once it was requested, file sorting couldn’t be canceled.

On the Data Filter dialog, the date delimiter could be confused with the decimal symbol.

On the Process Capability (Histogram) Parameters dialog, the “less than” setting wasn’t
saved when the Truncated Normal distribution was selected.

The Extract Definition dialog could produce a Run-Time error.

If Windows Regional Date format was Day/Month/Year and a key field was a date type,
Control Chart Limit Regions weren’t saved properly.

Files
-----
If a data set’s path included a Share name containing spaces, charting would fail.

Sorting a large file in-place could fail.

Utility functions such as Extract would fail with datasets on an unmapped directory when
the UNC file name was long.

Run files that referenced data sets on an unmapped Server with a name longer than eight
characters produced a lock error.  To accommodate long server names, you will need to
edit the configuration file QAEDIT.CFG.  In the section "[NWA Quality Analyst]",
change the value for "UseTempAsIODir" to "1" (one).  That is, make sure the
QAEDIT.CFG file contains:

[NWA Quality Analyst]
UseTempAsIODir=1

To find the location of this file on your system, start up QA, go to Help > About QA, and
look at the "Directory, Configuration".  Contact NWA QA Technical Support for further
assistance on this if needed.

Other
-----
The format of the graphics XML STAT_ID parameters wasn’t consistent.
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The $DATE (current date) parameter wasn’t processed in the title of the Exception
Report.

A lower control limit of “None” on attribute charts could lead to a Run-Time error.

Fixes to release 2.3.175
========================

The following problems have been fixed in release 2.3.185:

Graphics
--------
Control Chart comments with negative coordinates could fail when printed.

Control Chart and other routines could produce incorrect XML syntax in graphics files.
Graphics were still displayed correctly.

For Single Variable Regression, when more than one regression equation was displayed,
graphics colors didn't match the legend.

Formatted Data Report Summary Statistics could overwrite labels.

The "most recently used" graphics files list displayed short file names, not long names.

Wonderware IndustrialSQL Interface
----------------------------------
The IndustrialSQL interface could fail at startup with some Wonderware configurations.

Modifying IndustrialSQL connected data sets could fail if "Encode User ID and
Password" was selected. Encoded passwords were repeatedly appended to the connection
string and eventually caused failure.

Data Editor
-----------
Date and Time key columns only worked with the "M/D/Y" and "HH:MM:SS" formats.

Database denormalization could fail if the database column names had two or more
commas.

The "Save As..." action on a connected data set with filtered data could fail if the user
chose to abandon the save.
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The wrong toolbar buttons were enabled for type XS data.

Specifications were not allowed with Grouped Data (type GM).

Calculated columns were recalculated too often when a data set was opened.

RUN files
---------
The RUN file APPEND command failed if the data set contained a recalculation range.

The RUN file CALC command didn't work if the SetCurrentDir command was used.

The RUN file PAUSE command didn't allow access to the Graphics Window.

In a RUN file, file names using the "PLT" file extension were not converted to the
"NWG" extension if "plt" was lower case.

If QAEdit or a RUN file was started in a directory with a short file name path greater than
64 characters, chart servers failed and returned a COULD NOT START CHART
SERVER error.

Control Charts
--------------
Control limits couldn't be calculated on the control limits form if a variable with type XR
data was used.

Pareto Parameters dialog could fail if a single space was used as a category label.

With the Cumulative Sum Chart, graphics comments and Assignable Cause / Corrective
Action weren't saved to data sets.

Cumulative Sum Chart Assignable Cause / Corrective Action points were displayed in
the wrong color.

Statistics
----------
If simple regressions were produced for more than one equation, only the linear
regression results were displayed.

A previously saved Weibull location parameter could disappear if Weibull parameters
were modified.
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Fixes to release 2.3.157
========================

The following problems have been fixed in release 2.3.175:

Changing the printer settings in Quality Analyst modified the Windows default printer.

The RUN file "CONNECT" command didn't apply data or row tags after database data
was retrieved.

Charts created from a RUN file wouldn't allow Assignable Cause / Corrective Action to
be assigned unless the variable name in the RUN file was in uppercase.

Using the RUN file "CALC" command on a file with some Recalculation Range settings,
resulted in a Run-time error.

Connectivity parameters were stored incorrectly if the database field names contained
commas.

The Assignable Cause / Corrective Action report ignored $DATE, $TIME, $FILE, and
$FILEBASE parameters.

On a Windows system with only True Type fonts allowed (TTOnly=1), opening a data
set resulted in a Run-time error.

The Tz statistic was calculated only if LSL, USL, and Target were all available.

Creating a new data set based on a data set containing graphics comments resulted in a
Run-time error.

The Process Capability Histogram didn't display minor tick marks on the X-axis.

Using a single sided Data Filter based on alphanumeric data could gray out the wrong
rows in the editor.

The RUN File Wizard still used the "NWAVAR" environment variable.

Enhancements to release 2.3.144
===============================

The Run file command "SAVE" can now save graphics groups in addition to single files.

The graphics files (.NWG) now use "STAT_ID" attributes to identify numeric results.
For example, the Cpk of a histogram is identified with STAT_ID="Cpk". Since all
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Quality Analyst graphics files are in XML, this makes it easy for spreadsheets and XLST
transforms to extract numeric results.

The database connectivity option "Pass SQL to Database for Processing" is now only
applied to user written SQL. This allows Quality Analyst's interactive connectivity
interface to function no matter how the option is set.

Fixes to release 2.3.144
========================

The following problems have been fixed in release 2.3.157:

Using the CHART GROUP command with the /CLOSE option resulted in an error.

The APPEND command in a Run file would not allow description variables to be
changed.

If a Cause or Action was assigned to a row with an illegal value in a Key Column, control
charting could eventually hang the program.

The connectivity setting for "Encode User ID and Password" wasn't saved.

Changing the Key Columns of a connectivity data set wouldn't modify the query's "Order
By" clause.

If Windows Regional settings used a comma as a decimal separator, specifications read
from a database could lose the portion beyond the decimal.

On the Variable Definition and Specification dialog, specifications read from a database
weren't protected from user modification.

The Scatter Plot didn't display X- and Y-axis labels.

When Quality Analyst 5.2 PLT graphics files were opened the incorrect colors and
symbols were displayed.

Rainbow colors in charts were not displayed from Run files or Exception Reports.

If Windows Regional settings used a comma as a decimal separator, Rainbow Chart Zone
Limits could lose the portion beyond the decimal.

The Run Chart would only accept 32767 plotting points.

The Graphics display window was slow to close if virus-checking software was running.
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The list boxes on several dialogs were too short.

Once a connectivity data set was defined, it couldn't be converted to a denormalized
connectivity data set.

Connectivity data sets using ODBC (SQL Server, Oracle, etc.) would succeed when
opened in the data editor, but fail with a Run file CONNECT statement.

The File Utility "Rotate Data File" would fail to execute.

---
Northwest Analytical, Inc.
111 SW Fifth Ave, Suite 800
Portland, Oregon USA 97204
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